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1 Introduction

Grant applications for the Europe for Citizens Programme must be made using the eForm.
Applications submitted on paper by post, fax or e-mail will NOT be accepted for further evaluation.

The purpose of this document is to provide guidance on the technical aspects of completing and
submitting the eForm. It does not replace the document Europe for Citizens Programme Guide and
CORRIGENDUM which must be read and consulted by applicants for all guidance on the content of
the application form.

CORRIGENDUM, published in December 2010 applying to:
e Action 1 Measure 1.1, Town twinning citizens' meetings: new flat rate system!
e Action 2 Measure 3, Support for projectsinitiated by civil society organisations:

o new maximum for eligible grant and rate of co-financing;
o hew maximum project duration and submission deadline.

The Programme Guide and CORRIGENDUM can be found on the following webpage:

http://eacea.ec.europa.eu/citizenship/programme/programme guide en.php

Please note that the terms 'eForm’, 'form’, "application form' and 'online application form' are used
interchangeably throughout this guide.

Y ou are strongly advised not to leave the preparation and submission of your application form until
the last days before the deadline for applications

Please read all of thisUser Guide before beginning your application

2 Technical Requirements & Considerations
The online grant application form is an interactive PDF form that requires Adobe Reader software.

Theformisan 'online’ form because it is retrieved by you from the EACEA website and must be
submitted whilst you are connected to the internet. However, in between the retrieval of the form and
its submission, the form works as an offline document i.e. it isstored on your local computer and is
filled out by you on your local computer.

Adobe Reader

The minimum versioni.e. lowest version of Adobe Reader that you must have installed on your
computer is version 8.1.5. Y ou may also use ahigher version than this e.g. 9.0, 9.1 etc. If you have a
lower version than 8.1.5, you will not be able to complete and submit the eForm.

Follow the link below to be directed to Adobe's website to download the software free of charge or to
upgrade your existing copy of the software. If you do not have administrator rights on your computer
this activity may require the intervention of your IT department. Y ou will need to specify your
operating system before the download can commence.

http://get.adobe.com/reader/otherversions/
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If you are using Adobe Acrobat (Standard) or Adobe Acrobat Professional, the version must likewise
be 8.1.5 or higher.
The screenshots in this User Guide are based on version 8.1.5 of Adobe Reader.

Y ou can check the system requirements for Adobe Reader —i.e. the minimum required specification of
your computer — through the following link:

http://www.adobe.com/uk/products/reader/systemreqs/

Security settingsin Adobe Reader and Adobe Acrobat
If you are using one of the following Adobe Reader or Adobe Acrobat versions

8.2 or ahigher version 8 than this
9.3 or ahigher version 9 than this
X or ahigher version X than this

you may need to temporarily disable the Enhanced Security feature that these versions incorporate. If
you do not do this, the security settings may prevent the submission of your form. The disabling of the
Enhanced Security is performed from the following Adobe Reader menu path:

Edit > Preferences > Security (Enhanced)

Uncheck the box Enable Enhanced Security and click OK. Once the submission has been performed
you can re-enable the Enhanced Security. For more detailed instructions (including screenshots),
please refer to the relevant ‘Known Issue’ on the following webpage:

http://eacea.ec.europa.eu/ef orms/index en.php#issues

Here you will also find instructions on how to leave Enhanced Security turned on but identify your
eForm as atrusted item so that its submission is not blocked.

Internet Connection & Browser software
Y ou will require an internet connection and standard browser software to retrieve and submit the
online application form.

Test eForm
A test eForm is available on the EACEA eForm index page:

http://eacea.ec.europa.eu/ef orms/index _en.php

The form contains a small number of questions and functions. It has been designed to help applicants
understand how the main fields in the eForm work and also to ensure that their own software and
internet connection allow an application form to be submitted. It is NOT mandatory to use this form; it
is provided as a help tool for applicants who are using electronic submission for the first time.

Advice for Macintosh Users
The eForm can only be opened and completed using Adobe Reader or one of the Adobe Acrobat
products. It is not possible to open and work with the eForm using the Mac Preview viewer.

Please therefore ensure that if your default viewer is set as Mac Preview, you nonethel ess open the
eForm with one of the Adobe products mentioned above. This advice applies to both the download of
the form —if you try to open it before downloading — and to the opening of the form for its genera
completion and submission. For more detailed advice, please visit the ‘ Known Issues’ section of the
EACEA eForm index page:

http://eacea.ec.europa.eu/ef orms/index en.php#issues
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3 The Online Application Process— Overview

(i)  Youdownload the eForm from the agency website, saving it to your own computer or local
network drive. Do not try to fill in the form directly on the website. The form can only be
filled in once you have saved it to your local computing environment.

(i)  You complete the eForm on your own computer (as an ‘offline’ document). Y ou do not need
to be connected to the internet for this and no connection to the EACEA website or any
Commission server is required. Completion of the form includes the attachment of the
annexes.

(iii)  You vaidate the form (on your own computer) to ensure that it is ready for submission.

(iv)  You connect to the internet and press the submit button to submit your form. Y ou do not need
to be connected to the EACEA website or to any particular webpage — this connection to the
Agency server happens automatically. (The submission process includes a mandatory save
both before and after the submission. These save operations are instigated by the form itself.
Thisisexplained in detail in section 8.)

(v)  If the submission is successful, a submission number will be automatically generated and
added to your form.

(vi)  You can print the form for your own records.

(vii)  Anemail acknowledging receipt of your form is automatically sent to the email address that
you entered for the contact person of the Applicant Organisation (Part A.3).

4 Working with the eForm

41 Download the eForm from EACEA

A link to aread-only copy of the form can be found on the EACEA eForm index page:
http://eacea.ec.europa.eu/eforms/index_en.php

Save the form to your local computer or network drive, respecting the following filename convention:

Action and/or Measure reference_applicant SO country code_applicant organisation name_AppForm.pdf
e.g. Measure 1.1 BE_MyCompany_AppForm.pdf

Y ou can now open, save, close, print etc the file in the same way you would any other document you

had saved or created on your own computer.

4.2 Adobe Reader —a brief introduction to some key features of the pdf form

1

Activate the Activate _
Highlight Fields Page Thumbnails
facility (see below)
VERY

USEFUL!

__ G —
DO NOT USE!

The eForm hasiits
own attach facility

Adobe Help for
common features

Navigation panel,
on the left-hand
side of the screen
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Toolbar

From the Tools menu you can customise your toolbar e.g. you can add the Save button if it is not
aready displayed. There are also various display and navigation options that you can add.

File Edit “ew Document pindow  Help

=Rk L aErricas = =N .

1L Copy
File Toolbar
[]open
=iPrint
h:-i Save
[ & attach a File.,. *
] nSearch
[ ] E=Email
Ll skart Meeting. ..
Find Toolbar
Measuring Toolbar *
Object Data Toolbar
Page Display Toolbar
= 5crolling Pages
k| one Full Page -
|:| ﬁ Single Page Continuous
] |J Single Page
T L wo-up
F ﬁ'ﬁ'Twu:u-Llp Continuous
(1 I Full Screen Mode
F @F{Dtate Counterclockwise
F .?chutate Clockwise

| B .

%)

|F3

Customise
toolbar
selection menu
(partia view)

EOOE

| &

Explained here are some of the commonly used display and navigation options:

Fit form to

width of
screen and
Move scroll across
back 1 page
page I Tools Window Help boundaries

ey X

Turn on ‘Page

View' —
Zoom In Zoom Out 1 whole page
(reduce (enlarge displayed ata

time

image size) image size)
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Page Thumbnails

If you activate the Page Thumbnails option, anew panel is opened up on the left-hand side of the
screen. It contains miniature previews (‘thumbnails') of each page:

bile Edb Wew Uocument looks  Window Help

{5 B @ %217 88w 32 1 | T

Form version : 0.07 EIN _Adobe Reader version : 8.103 * U% the 3
thumbnails to
Part A: Identification of the aj jump to different
in the r” oject. areas of the form.

Parts A and B must be completed :

e A frame outlined

in red indicates
A.1 Organisation where you arein
the document.
Partner number P
Red frame : S Role in the application *: ° R| ght CI | Ck on the
I ndl catl ng - Full name of the organisation * : _ panel to access
yOU-r - Fullname of the organisation in Latin Opt| onsto enl ar ge
location S characters (if applicable) B or reduce the
Acronym *: thumbna| I S.

Department, if applicable

Registered address:

Street*:

Zoom in/ Zoom out

Torapidly zoom in or out, press CTRL on your keyboard and move the scroll wheel on your mouse:

Scroll up to zoom out, increasing the size of the image
Scroll down to zoom in, decreasing the size of the image

4.3 eForm completion

The eForm is an interactive PDF form that contains form fields that are either selected from a
restricted list or filled in using free text:

Click inside atext field to enter data.

Click to select options from e.g. dropdown lists and radio buttons.

Press Tab to move forward one field or Shift+Tab to move backward one field.
Point and click with the mouse to select a specific field.

Please note that when you use the tab facility, the tab doesn’t just ‘land’ on modifiable form fields — it
also lands on the various buttons and unmodifiable form fields that appear in the form. In order to
reach the next field that you wish to complete, simply continue tabbing until the cursor point arrivesin
the desired field.
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44 Mandatory, optional and calculated fields

Field Type Characteristics Examples
Field label is Telephone 1%:

Mandatory accompanied by an Agreement n°*
asterisk *

Optiond | Field label hasno asterisk | ="
Calculated Field contains diagonal
automatically | grey lines.
D . P1 Coordinator
uration 0

How to highlight mandatory fields

Click on the purple button in the navigation panel and thiswill activate the Document message
bar which incorporates the Highlight Fields feature.

Click on the Highlight Fields button and all
mandatory and optional fieldswill gain
highlighting that makes them easier to identify
(and easier to differentiate from one another).

Mandatory fields— red border and alight blue background
Optional fields— light blue background (and a black border when you hover the cursor over them).

Unhighlighted fields Highlighted fields

Country *: Region *: ICUU""V WH N u |Rﬂi_on *:

Internet address:

Internet address:

Telephone 1*: Telephone 2 Telephone 1*: Telephone 2

Please note: if any mandatory field remains incomplete the eForm will not validate successfully and it
will not be possible to submit your form. Where anumerical field is mandatory but you have no value
to enter e.g. in table C.4, please make sure you enter a zero to indicate your null value.

Once you have activated the highlighting you can click the purple button again to remove the
Document message bar (and maximise the display of your form).
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45 Saving your form

To save your form, click on the Save button on the toolbar or select Save from the File menu or press
CTRLand S.

File Edit Wiew Document Tools wWindow Help

SN
2@ & €=l 0ol [H @ :

—

Please ensure that you save your form on aregular basis. If you encounter a problem in your local
computing environment and your form or your computer crashes, the Adobe Reader auto-recovery
function will only restore your form to the point of the most recent save.

4.6 Entering Dates and Numbers

Please respect the following rules when entering dates and numbers on the form:

Rule Example

Numbers Commas act as decimal commas 50,75 for fifty euros and
seventy-five cents

Dates All date fields are in the format

st
dd/mmlyyyy 01/10/2011 for 1™ October 2011

Telephone numbers | Norules- thisisafreetext field -

4.7 Using the Add and Delete buttons (e orm tables)

Some fields or groups/ blocks of fields are required to be completed more than once alowing you to
build up a'table’ of information e.g. the list of organisations involved in your project or the details of
the Twinnings. Whenever you need to insert a new 'blank’ field or add rows to atable, you will do this
by using the Add buttons.

These buttons are coloured green. Click on them to add the desired new field or table row.

Programme concerned* Amount requested*
Add a programme =

Click hereto
deletearow

Click hereto
add anew

Programme concerned™ Amount requess=d’

Add a programme

Once you have added afield or row, the delete facility — an orange-coloured button containing an 'x' —
appears so that you can delete the field, block of fields or table row concerned (and its contents!).

Please note: some tables are optional but contain fields that are mandatory once a row has been
added. An example of this can be seen in the screenshot immediatel y above (Part B.3, table 2).
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4.8 Formatting

If you enter formatted content into the form e.g. through copy-and-paste from other document sources,
the eForm will strip off the formatting and plain text only will be pasted into the form.

Please do not copy bullet points into your form. The formatting of some bullets can trigger the
requirement to download add-ons to your Adobe Reader software (so that it can handle those bullets).

49 Character Limits

The free text fields in the eForm have character limits that restrict the amount of text you can enter.
These limits include both characters AND spaces. If you try to enter more characters than the limit
allows the form will simply restrict the text to the predefined limit. Many word processing packages
have a 'count’ tool that may help you respect the limits.

For the mgjor fields, the limits are displayed in the headings and sub-headings of the eForm. For other
fields, please consult the following table:

Part Field Character Limit
Project Title 300
Project Acronym (see section 5.1) 7
Full name of the organisation 62
Name in latin characters 62
Acronym (organisation) 62
Department, if applicable 40
Street 57
Street Number 5
A Postcode 12
Town 60
Internet address 60
Telephone 1 and Telephone 2 60
Fax 60
Family name 62
First name 62
E-mail 100
Role in the organisation (A.2 and A.3) 32
Programme or Initiative 25
Agreement no. 15
B.3 Contracting organisation 25
Project title 25
Programme concerned 60
C2 Venue(s) of the activities 2,000
E1l State how your project fitsin... 3,500
E2 Pertinence of the project and methods proposed 3,500
EA4 If one or more of the three types of communication tools... 1500 for each occurrence
Type of Activity 200
F Venue of the activity 60
Content 500
Expected results 500
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4.10 Synchronisation with your recorded Organisations

Parts C.3 and C.4 — which require information to be supplied on a per partner basis — are synchronised
with the organisation information that you enter in Parts A and B of the form. The synchronisation
features will be explained in more detail in section 5 of this guide. (Please note: Part C.3 only appears
in the form if you have selected either Action 1, Measure 1.1 or Measure 1.2.)
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5 Guidancefor specific Parts of theform

5.1

Cover Page

Important!

Please ensure that you complete al the fields of the Cover Page (page 1) before going on to
complete the rest of the form!

This is because the selections that you make, dictate how the rest of the form appearse.g. a
different budget table appearsin Part C.6 for each Measure that can be selected.

Please ensure that you only choose Actions and Measures for which applications are
currently being solicited by the Agency. If you are in doubt, check the Citizenship funding
opportunities webpage:

http://eacea.ec.europa.eu/citizenship/funding/2011/index en.php

Where you are required to select the Round value please select the Round that generates the
date (Deadline for submission) of the next scheduled deadline for your Action / Measure.
Do not select a Round for a deadline that has expired or a Round that has adeadline that is
not the next scheduled deadline. If you do so, you will not be able to submit your application.
If you are in doubt, check the Citizenship funding opportunities webpage.

The Project acronym field is limited to 7 characters. If you require an acronym that is longer than this,
please include the full acronym of your project at the start of your Project title and then enter the first
7 characters of the acronym in the Project acronym field.

5.2

Parts A and B — Organisations

For each organisation in your consortium apart A and a part B must be compl eted.

The‘Rolein the application’ field is not afield that you can modify. Instead, itsvalueis
dependent upon the Partner number value. The roles and partner numbers are set as follows:

o Plisautomaticaly set to havetherole of Applicant.

A.1 Organisation

Partner number P1

Role in the application Applicant

o For subsequent partners— P2, P3 etc — the role is automatically set to Partner.

A.1 Organisation

Partner number P2| _——

Role in the application Partner
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e Thefield ‘Internet address’ in Part A.1 relates to the organisation’ s website address.

e Because parts A and B taken together represent the details of a single organisation, the form
‘numbering’ does not follow a‘pure’ A, B, C, D, E, F but evolves as follows:

A, B,A B A BABA,B......... C,D,EF

o Attheend of Parts A and B, asummary table —the List of partner organisations—is built up
for you automatically. As you enter your partnersin Parts A and B, the List updates to reflect

the content you have added.
List of partner organisations
Partner no Role Organisation Name City Country
P1 Applicant Organisation 1 Brussels Belgium
P2 Partner Organisation 2 Santander Spain
P3 Partner Organisation 3 Copenhagen Denmark

Please note: this List is protected and cannot be used to add or delete organisations. This can
only be done through the green Add and orange Del ete buttons described earlier.

Tip

When selecting a country value, instead of deploying the dropdown list, enter the initial letter of the

I SO country code into the field. Thiswill take you to the first country codein the list that begins with
that letter. Press the same letter again to bring up the next country. For example, entering the letter ‘s
three timesin succession would bring up:

SE — Sweden
then Sl —Slovenia
then SK —Sovakia

The up and down arrow keys on the keyboard can also be used to navigate the list — without deploying
the dropdown list — once an initia selection has been made.
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5.3 Part C—Description of the Project

C.1 Calendar of the project
Check the rules for your Action and Measure and then enter valid dates.

C.3 Proof of Twinning
This part only appearsin the form if you selected Action 1, Measure 1.1 or Measure 1.2 on the Cover
Page. If you selected any other Action / Measure, Part C.3 does not appear in the form.

When this part appears, it is synchronised with the organisations that you recorded in Parts A and B.
That isto say, for every organisation that you enter in Parts A and B, a corresponding section for you
to complete will automatically appear in Part C.3.

C.4 Participants
For every organisation that you enter in Parts A and B a corresponding row for you to complete will

automatically appear in the table in Part C.4.

All fields are mandatory. If you have no value for a given field, enter a zero. If any field isleft blank it
will fail validation.

C.6 Budget/grant calculator
The format and content of the budget table that appears is dependent upon the Measure that you
selected on the Cover Page.

If abudgetary rule has been broken, you will see red font in your table. Please ensure that all
budgetary rules are respected and that you have no red figures in the budget table.

Please attach to the eForm the correct budget form downloaded separately from the website of the
Agency and duly filled in. The exceptions to this, are applications for Action 1 Measure 1.1, Town
twinning citizens meetings, for which no grant calculation sheet/budget is required to be submitted.
Thisis because the grant is calculated automatically within the eForm, once you have completed the
budget tablein Part C.6.

Important! New flate system for Action 1 Measure 1.1 applications!

A new flate system has been introduced for Action 1 Measure 1.1, Town twinning citizens meetings.
Please consult the Corrigendum published in December 2010 before attempting to complete Part C.6:

http://eacea.ec.europa.eu/citizenship/programme/programme guide en.php

5.4 Part E —Project implementation / Award criteria

Specific aims of the action
The options that appear are dependent upon the Measure that you selected on the Cover Page.

E.4 — Types of Communication tools

If you selected Action 1, Measure 1.2 on the Cover Page, the types of communication tools —
Publications, DVD/CD-ROM and Website — become mandatory fields. For all other actions/
measures these fields remain optional.

55 Part F —Work programme

The format and content of the table that appearsis dependent upon the Measure that you selected on
the Cover Page.
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Y ou may add and use several work programmes to describe the same event. So, if you run out of
characters for your description simply add another work programme. This is done by clicking on the
Add a work programme button:

Add a work programme

For example, if your event runs over a number of days you can add a separate work programme for
each day. Or if your event consists of severa activities you can add a separate work programme for
each activity.
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6 Attaching Documentsto your eForm

All eForm applications must have attached within the eForm the following mandatory annexe:
o Declaration of Honour.

For al Actions/ Measures other than Action 1 Measure 1.1 afurther mandatory annex must also be
attached:
o Budget / grant calculation sheet.

For Action 1 Measure 1.1 there is no budget attachment for applicantsto provide and therefore no
corresponding attach button appearsin the form.

Please respect the following filenames and formats for your attachments:

Annex Required Filename Required Format
Declaration . . .
of Honour Declaration of Honour .pdf, .jpg or .jpeg
Budget Budget XIs or .xIsx

Attachment size limitation

Thereisalimit to the total (combined) size of your attachments. Thisis5MB. If you receive a
message advising you that the total size of documents exceeds the maximum allowed, please reduce
the size of the image-based documents e.g. by reducing their resolution.

To carry out the attach function, click on the relevant Attach a document button and a window will
pop up enabling you to browse, locate and select the file you wish to attach:

Warning: JavaScript Window - Select a data file to import

A ttaChmen ts Lock in: | [ Documents for grant application v Q G il
y "= Declaration of Honour ,pd.
)
Declaration of Honour Do
[ J — 1 " Click on the ‘Open’ button
7, to attach the selected file
by Dacuments to your application.
Budget 5l
My Computer
[ J .‘;L] File name: v
My Metwork  Files of type: Al Files (] v

Once afile has been successfully attached, the filename is displayed and the Attach a document
button is replaced by a Delete this document button and a View this document button:

Declaration of Honour

.
[ I Document: Declaration of Honour.pdf
_

Please note: your ability to view a document that you have attached is subject to the security settings
and the trust manager settings on your computer. Please consult your I T department or your
computer's help filesif you need to change the security settings or the trust manager settingsin order
to view an attached document. This phenomenon does not affect the document itself which retainsits
content and integrity.
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7 Validation of your eForm

The Validate Form button appears at the foot of every page of the form.

Validate form
It is recommended that you do not validate your form until you have finished completing it as
validation dlightly alters the look of the form.
When you are ready, click on the button and various checks will be automatically performed to
ascertain whether your form is ready for submission. For example, the validation will verify that all
mandatory fields have been completed and all the mandatory attachments are present.

If there are any errors present, the total number of them will be listed on the last page of your form. If
there are any budget or attachment errors these will be itemised separately in the same list:

Submit this form

Submission

000000000 number

Number of mandatory field(s) not filled in: 225

The declaration of honour has not been attached.

The budget tables have not been attached.

The errors themsel ves will be highlighted in pink. In the example that follows the mandatory field
Short description of the project has not been completed:

C.5 Short description of the project, including its aims in English, in French or in German (Max.
2000 characters).

When you validate, an additional button —the Go to Next Error button — appears next to the Validate

form button.
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Use this button to jump from error to error in your form. Please note the following:

When you fix the errors that are highlighted, the Errors List is not dynamically updated. It is
only updated i.e. refreshed when you perform another validation.

The Go to Next Error function works best when you fix errors one by one, following the top-
to-bottom sequence used by the Go to Next Error button. If you fix errors out of sequence
e.g. fix an error further down the form, the Go to Next Error function will still follow the
original sequence of errors reported by the validation.

If you have fixed errors out of sequence, you are recommended to perform afresh validation
so that the errors you have fixed are removed from the sequence (and you would then start
again from the error nearest the top of the form).

If you prefer, you can simply do a visual search for the pink errorsin your form. If you do
this, it is recommended that you first turn off the highlighting for mandatory fields (see
Section 4.4). Y ou may find the thumbnail view a useful aid to quickly detecting the pink
highlighted fields (see Section 4.2).

Whichever method you use, fix the errors that are present and validate your form again. If al errors
have been resolved you will see the following pop-up message:

Warning: JavaScript Window -

\v The form is walid For submission!

Until your form validates successfully the Submit button is disabled and it will not be possible to
submit your form. The Submit button turns from grey to green when validation has been carried out
successfully.
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8 Submission of your eForm

On thefina page of the form isthe Submit this form button. Once your form has been successfully
validated the button is enabled (as confirmed by its green colour). Click on this button to launch the
submission.

Submit this form

The following message will appear:

Warning: JavaScript Window - Submission confirmation

ou are about ko submit wour application, This process can take some time.,
x._-{’ Do wou wank bo continue?

es I [ Mo

If for any reason you do not want to continue, you may click No and carry out the submission at alater
time. The submission process will end. Once you click Yes your form will be locked and it will no
longer be possible to modify its content.

8.1 Themandatory save BEFORE submission

If you click Yes, the next step of the submission process is amandatory save. The following message
appears:

Warning: JavaScript Window - Save Before Submission

' ‘fou miusk now save your Form before the submission process starts,
Please keep the SAME FILEMAME For wour Form,
Do not change the filename during the save.

When you click OK, the form triggers a Save As operation. Y ou will see the classic Save As window as
appears in the screenshot below.

(Please note: the screenshot below is simply an example of the Save As window. The window that you
see, will reflect the filename and directory name that you have been using.)
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)X

E?Measure 1.1_BE_MyOrganisation_AppForm, pdfi

Example screenshot

q. |
|

Type: Adobe Acrobat Docurment
Filz Size: 1334 KB
Modified:06/07 /2009 17118

File name: |Measure 1.1_BE_MuDrganization_AppFarm.pdf ¥ | [ Save ]

Sawve az type: |.6.dobe POF Files [~ pdf]

- | [ Cancel ]

Y ou must now perform the Save As operation by clicking on the Save button.

Very Important!

You must NOT change the filename of your eForm.
Y ou must keep the same filename that the file had when you began the submission operation!

Click Yeswhen you are asked if you want to replace the existing file:

- The file already exists,
Replace existing file?

Yes

1My FilesiMy eForm applicationtStrand 1.1 _BE_BestCo_AppForm. pdf

8.2 Submission

Depending upon your security settings, the following pop-up window may now appear:

The document is trying ko connect ko
' htkp:f/eacea. ec.europa. eufWSEMLR eceiverfx 1 fservices '\WarMLRaceiverfx 1 7
[

wsdl

If wou trusk the site, choose Allow, IF wou do not krust the sike, choose Block,

CIRemember my ackion For this sites

Help

] [ Allowy ] [ Block:
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If the window appears, click on the Allow button in order to proceed with the submission.

When the submission is complete you will see a pop-up message as follows:

Warning: JavaScript Window - Successful Submission Message

i Details of the resulk: Success, your submission number is;
\f) 52631 3-EFC-1-2011-1-BE-ERC-CM

Please, 3A%E and PRIMT the application Form before closing i,

Click ‘OK’.
8.3 Themandatory save AFTER submission

When you click OK, the form triggers another Save As operation. Thisis so that you cannot
mistakenly close the form without saving (and so |ose the submission number).

Once again you will see the classic Save As window appear:

Save As @@

Sawe in: |'L;"}M_|,J eF arm application V| ¢ T" ¥ "

TiMeasure 1.1_BE_MyOrganisation_AppForm, pdfi

al

ty Fecent

Documents
F .
Desktop Lo
% Example screenshot

Twpe: Adobe Acrobat Document
ky Documents File Size: 1334 KB
Modified:06)07/2002 17:18

|
ty Computer
e File name: |Measure 1.1_BE_MyOrganization_appForm. pdf % | [ Save ]
MyMNetwork  Saveashpel | Adobe PDF Filss [* pdf] v| | cance |

Y ou must now perform the Save As by clicking on the Save button.

Very Important!

You must NOT change the filename of your eForm.
Y ou must keep the same filename that the file had when you began the submission operation!
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Click Yeswhen you are asked if you want to replace the existing file:

Save As |§|
L4y Files\My eForm application|Strand 1.1_BE_BestCo_aAppForm. pdf
- The File already exists,
Replace existing File?

When you click ‘ Yes', the submission number is automatically added to the * Submission number’
box:

Submission

526313-EFC-1-2011-1-BE-EFC-CM
number

It isalsoinserted into the footer of your form. The form has also been saved and this save included the
submission number.

Y our submitted formisnow ‘locked’ . That isto say, it has been converted to aread-only document:
changes cannot be madeto it and it cannot be re-submitted.

As part of the submission process, an email message acknowledging receipt of your eFormis
automatically sent to the email address you entered for the contact person of the Applicant
Organisation (Part A.3).

As advised by the earlier pop-up message, you may now print the form for your own records.

*** Please Note! It isNO longer required to send to the Agency by post a printed copy of the
eForm and its attachments! ***

For details of the documents and annexes that must be submitted by post, please follow the relevant
Action / Measure link from the funding opportunities webpage:

http://eacea.ec.europa.eu/citizenship/funding/2011/index_en.php

*** The submission number must be clearly written on all documents submitted by post! ***

9 Printingyour eForm

The eForm can be printed using Adobe Reader’ s standard menu-driven print function. The Print
button is found on the tool bar, or the Print menu can be selected from the File menu.

Eil dit  Wew Document
(5)8 &-

10 How to obtain technical assistance —eForm HelpDesk

If this User Guide does not provide answersto al of the technical questions or problems you
encounter in completing the application form, atelephone and email HelpDesk serviceis available to
assist you further:

eForm HelpDesk: +32 229 90705
eacea-exter nal-hel pdesk @ec.europa.eu
Monday to Friday, excluding Belgian public holidays
09:30to 12:30 and 14:00 to 16:30 CET / CEST (Brussels time)
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Should you experience what you believe to be a significant technical issue with the eForm it will be
worth checking the Europe for Citizens programme website since, in the event of a general technical
problem, an update bulletin would be posted.

Y ou may also visit the Agency’ s dedicated eForm webpage which contains the latest versions of all
published forms along with a Test eForm and other items of information:

http://eacea.ec.europa.eu/eforms/index en.php

Non-technical assistance

If you require assistance with aquery or problem that is not technical in nature, please do not contact
the eForm / External Helpdesk. The External Helpdesk team are only authorised and trained to help
applicants who are encountering technical problems.

Please refer instead to the funding oppor tunities webpage of the programme/action that you are
applying for. On this webpage you will find details of how to obtain non-technical assistance e.g.
assistance with questions on:

e the content of the eForm;
e theapplication processincluding instructions for providing the backup copy;
e therulesof the programme/ Call that you are applying for.

Generally speaking, the funding opportunities webpage will include the mailbox address of the
Operational Unit that is responsible for the programme/action that you are applying for. The page will
also contain documentation that may already provide an answer to your non-technical question e.g. a
Programme Guide or Instructions for Applicants document or alink to an in-country Helpdesk which
can help you. If you cannot find the answer to your question, please contact the mailbox of the
Operational Unit cited on the funding opportunities webpage.

The following table provides some examples of technical and non-technical questions.

Technical Questions Non-technical Questions
(handled by the External Helpdesk) (handled by the Operational Unit)

What is required to be entered for the field Other

| can’'t download the form. Community Grants?

A dropdown list isn't working. Why isn't country A in the dropdown list?

| can't attach my budget form (or other

annexelattachment). I need help with completing my budget form.

How does the synchronisation of fields work? Why isthis field mandatory?

Our project has more than one coordinator.
What should | do?

What is the minimum / maximum number of partners that
isallowed?

What documents are required for the paper

| can't delete atable row that | have entered.

My form freezes/crashes. .
backup and where do | send it?
My form is working slowly. | need more characters for my answer!
My form won't validate. What do you mean by the term ‘ acronym’ ?

Where are the templates for the attachments and

My form won't submit. additional documents?

What should | enter in the form for my project start and

| think there isabug in the form. end dates?
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